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Chapter 1

Scope and Purpose

1.1 What is AMPL?

AMPLI48] is an algebraic modelling language that is used for formulating and solving optimization
problems. AMPL supports linear and non-linear programming optimization models covering both
discrete and continuous variables. Stochastic extension of AMPL (SAMPL) has comprehensive support
for stochastic programming; SAMPL is an extension of AMPL. You can easily create models and
establish connection to various data sources, such as spreadsheets, databases or plain text files,
within AMPL. From the model and data, the AMPL translator generates an internal representation,
passes it to one of the many solvers supported by AMPL and provides you with the results. The
language is simple and generally follows the mathematical notation used by both mathematicians and
practitioners in the field of operations research.

AMPLDev SP is a graphical interface for AMPL. It is based on the popular Eclipse development
platform and is available as a stand-alone application and as a plug-in for Eclipse.

For a general introduction to AMPL see [48]; a description SAMPL may be found in (reference).

AMPLDev SP as a stand-alone application

This version is a complete bundle of the necessary components required to run AMPLDev SP without
the complications of installing any prerequisites. You can think of it as a core Eclipse IDE with the
AMPLDev SP plug-in preinstalled. The only drawback is that this stand-alone version of AMPLDev
SP may have limited capabilities of extending with other Eclipse plug-ins.

If you do not require Eclipse for any other reason, then we recommend installing this version of
AMPLDev SP.

1.2 Who can use AMPLDev SP?

AMPLDev SP can be used by anyone who is considering using an algebraic modelling language and
would like a quick and easy way to start off the process of learning AMPL, and even for those who
are already using AMPL and would like a modern IDE for this language. The common areas that use
such a tool are distribution, production, scheduling and other areas that have large-scale optimization
problems.

To use AMPLDev SP, you are expected to have a basic knowledge of programming and some
optimisation modelling experience. Experience with Eclipse or any other development environment,
although not required, will considerably speed up the learning process.

1.3 Why use AMPLDev SP?

AMPLDev SP gives AMPL users the benefits of a modern Integrated Development Environment (IDE)
which has the following features.


http://www.eclipse.org/
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A smart editor with context-sensitive syntax highlighting.

Efficient error reporting with the ability to instantly go to the error location.

A solution view which organises and separates the results from solving the model.

A project explorer that allows you to organise all your projects and corresponding folders with
useful context menus that directly allow you to run AMPL files.

Built-in interactive AMPL console.

Outline view that shows the model components: parameters, sets, variables, objectives and
constraints.

For users who are new to AMPL such as students who are learning modelling using AMPL for the
first time, the carefully designed Graphical User Interface (GUI) helps to easily get started. At the
same time AMPLDev SP is beneficial for advanced users who need such features as built-in interactive
console, integration with version control systems provided by Eclipse and projects supporting other
programming languages in addition to AMPL.

For the users who wish to install the plug-in version of AMPLDev SP, Eclipse is absolutely free to
use and has minimal installation requirements. Integrating AMPL with Eclipse is a huge advantage
if you are already an Eclipse user and can have one software that takes care of all your development
needs. In addition, you can even extend the AMPLDev SP plug-in if you wish to customize it further
for your needs.



Chapter 2

Installing AMPLDev SP

This chapter describes how to set up your computer for using AMPLDev SP. The first section covers
installing the AMPLDev SP stand-alone application which is the essential step of getting started
with AMPLDev SP. The second section describes how to install the AMPLDev SP plug-in in Eclipse;
primarily for advanced users.

2.1 AMPLDev SP stand-alone application

This is the fastest way to start using AMPLDev SP. Download the archive from the website onto your
local machine, unless you have already received the archive via other means.

Once you extract all the files from the archive, in the root folder you will find the AMPLDev SP
executable, double-click it and you are good to go!

The stand-alone application does not require any Java Runtime Environment (JRE) or Eclipse
installations as these items of software are all bundled in with the executable.

2.2 AMPLDev SP plug-in for Eclipse users (Not supported yet)

If you already have Eclipse set up on your machine (a version from 4.1 onwards), then you may skip
the next two sections.

First, install the JRE on your machine. Following that, the next section describes how to get
Eclipse and install it. The last subsection explains how to install the AMPLDev SP plug-in into your
Eclipse Platform so that you can program in AMPL using Eclipse.

Java Runtime Environment installation

The JRE needs to be installed to run Eclipse. You can download the latest version of the JRE by
following the link, http://www.java.com/en/download/manual.jsp. It is recommended to use
the JRE of version 7 or higher for the Eclipse version (Eclipse Juno 4.2); our system which is based on
this version, is described in this manual. If you already have a JDK installed, make sure it is version
1.7 and up.

TIP:

Many computers already have the JRE installed but if you are not sure, the Java website has a
nice tool that checks your computer for you and asks you to download the latest version if you do not
have any or if you need an upgrade. You can either search for 'Do | have Java?' or use the following
link, http://www.java.com/en/download/installed. jsp?detect=jre&try=1.



http://www.java.com/en/download/manual.jsp
http://www.java.com/en/download/installed.jsp?detect=jre&try=1
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Getting Eclipse

Once you have the JRE set up, your computer is now ready for Eclipse. The version used throughout
the book is Eclipse Juno 4.2 and can be freely downloaded from the Eclipse website (http://www.
eclipse.org/downloads/). For users, who wish to use a previous version, it is recommended to
use only versions from Eclipse 4.1 onwards.

On the download page, there are many different types of Eclipse Juno packages available; we
recommend that you download the Classic version. Most of the others focus on a specific development
area such as Java or PHP but the Classic version is an all round Integrated Development Environment
(IDE) with all the relevant tools needed for our purpose. Eclipse is available for major operating
systems (Windows, Linux and Mac OS) and supports 32-bit and 64-bit platforms.

TIP:

Some 64-bit machines may have a 32-bit JRE installed; that is fine as long as the Eclipse is also
32-bit. Hence when downloading Eclipse, it does not depend upon your machine but upon the JRE
installed. For example, a 64-bit Eclipse will not work on a 64-bit machine with a 32-bit JRE; either
get a 32-bit Eclipse or a 64-bit JRE.

You can choose from numerous mirror sites, available across Europe, Asia, North America, South
America and Australia, depending upon your location for better download speeds.

Once the file is downloaded, unzip it at your desired location. As such, there is no setup file that
needs to be run for the installation. Then run the eclipse executable (eclipse.exe for Windows' users)
which is located inside the extracted ‘eclipse’ folder. But don’t forget to install the AMPLDev SP
plug-in if you would like to use AMPL!

Installing AMPLDev SP plug-in

There are two ways to install the AMPLDev SP plug-in; these two ways are described below.

Installing AMPLDev SP plug-in via update site - recommended

1. Once you have downloaded the AMPL plug-in archive on your computer, start Eclipse and click
on Install New Software... in the Help menu.

2. Click on the Add... button.

3. If you have extracted the plug-in file, click on Local... and navigate to the AMPL plug-in folder
or do the same with Archive..., if you have not extracted the AMPL plug-in.

4. Click on OK and the Install New Software... window will list the available AMPL plug-in.
5. Select the plug-in and click Next.
6. Follow the default settings and the AMPL plug-in will be installed.
7. Restart Eclipse and you should have AMPL support!
TIP:

If you cannot see the AMPL plug-in listed as an option to install, uncheck the Group items by
category.

Installing AMPLDev SP plug-in manually

1. Extract all the files from the AMPL plug-in archive to any location. The location does not
matter as you will soon be copying the required folders into Eclipse.


http://www.eclipse.org/downloads/
http://www.eclipse.org/downloads/
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2. Once the archive has been completely extracted, you will find a ‘plugins’ folder inside it. Copy
the contents.

3. Navigate to the folder where you have installed your Eclipse. Inside the ‘eclipse’ folder, you

will see a folder named ‘dropins’. Paste the previously copied ‘plugins’ folder into the ‘dropins’
folder.

4. Repeat the previous two steps for the ‘features’ folder in the extracted plug-in archive by copying
the contents into Eclipse’s dropins’ ‘features’ folder.

5. Simply start Eclipse or restart it (if it was already running) and you should have AMPL support!



Chapter 3

AMPLDev SP User Interface

In this chapter the Graphical User Interface for AMPLDev SP is described. The basic interface
is described here along with its various parts and some important menu items as well. You will
notice that there are many features provided by Eclipse which are for more advanced users and are
not paramount to using AMPL. For Eclipse features, we recommend referencing the Eclipse Help
sections. This document pertains to AMPLDev SP and we will describe the various functionalities,
views and graphical tools relevant to AMPL.

3.1 Workbench

Once the computer has been set up for AMPLDev SP (see chapter 2), run the ampldev executable
(ampldev.exe for Windows' users) to start an AMPLDev SP session. When AMPLDev SP starts,
it will ask for a workspace; this is essentially a directory on the computer in which it will save the
projects (see figure 3.1) you create.

..\ Workspace Launcher

Select a workspace

AMPLDev stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

Workspace: | [MRYIHRUTIEEETD - Browse...

Use this as the default and do not ask again

Figure 3.1: Workspace selection

TIP:
You can change the workspace any time by choosing Switch workspace... from the File menu.

The workbench is the interface that you will see when you start AMPLDev SP (3.2) . This is where
you can manage the whole project life-cycle, from creation to the final product. A workbench window
has menus and toolbars along with perspectives, where a perspective is a customized collection of
views and editors based on the purpose of the perspective.

AMPLDev SP allows users to open multiple sessions of the workbench. Therefore while a win-
dow/workbench is open, by running the eclipse executable file again, another window will open that
can be used with a different workspace.
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\ AMPL - Demo/AModel.ampl - AMPLDe

File Edit Mavigate Search Project Run Window Help

- iR & e 5| 1w a8 - 0 - Q-3 - -] Quick Access | B A
75 Pro... 22 = 8 [Fi] diet.mod [Fi] diet.dat [A] AModel.ampl &2 = O B Solution &3 = B8
= <===€|> = set PROD ; # products - Objective:

A

leALM . param rate { PROD } > @; # tons produced per hour Variable Value Reduced Co

1= Bondstripping param avail »>= @; # hours available in week

=2 Demo

12 Diet param profit { PROD }; # profit per ton

4 Production param market { PROD } >= @; # limit on tons sold in week

A

(= Tracking var Make {p im PROD } >= @, <= market [p]; # tons produced 5
# Objective : total profits from all products
maximize Total_Profit : sum {p in PROD } profit [p] * Make [p]; 1 1L »
# Constraint : total of hours used by all Constraint  Body Dual Valu

Constraint : total of hours us y all

# products may not exceed hours available
subject to Time : sum {p in PROD } (1/ rate [p]) * Make [p] <= avail ;

data ;

set PROD := bands coils ;

param : rate profit market := -

Bl Console 22 o ~fr= 8

Mo consoles to display at this time.

Writable Insert 23:22

Figure 3.2: AMPLDev SP workbench

3.2 Perspectives

Although perspectives is an advanced topic and meant particularly for people interested in using
AMPLDev SP along with Eclipse, we have mentioned it here briefly since AMPLDev SP as a stand-
alone does allow you to change perspectives.

A perspective is a customized layout of views that is set in an efficient and useful way for the
purpose it was created. These views are set around an editor which is used to edit your files. You
can move the views around to place them in a manner that you desire and these preferences will be
saved for the next time you start a session.

There are two ways to get the AMPL perspective. The AMPLDev SP stand-alone generally starts
with the AMPL perspective already but for some systems settings, it might not. Switching to the
AMPL perspective can be achieved in one of the following ways:

e In Window menu, select Open Perspective..., choose Other... and then click on AMPL.

e Create an AMPL project; and if you are not in the AMPL perspective, AMPLDev SP will ask
you to change to the AMPL perspective upon the creation of the project.

Although it is not necessary to use the AMPL perspective for using AMPL, the layout is what best
suits for AMPL modelling.

There are also many AMPL-specific shortcuts that are available easily when in this perspective.
They will be discussed in later chapters but one example is the toolbar which has buttons to create
AMPL projects and files without going through the File menu.

3.3 Views

Views provide for smart ways to represent any kind of information; such as the Project Explorer which
shows an easy-to-understand tree structure of all the parts of a project: files, folders etc, collectively
known as resources. Views are also handy to navigate through large systems of information.

A perspective contains a set of views that open automatically when the perspective is selected.
Although, you can also open views that are not part of the current perspective via the Window menu
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item and then selecting Show View.... As described previously, these additional views opened in a
perspective are saved under the perspective.

Views can be moved around at any time by clicking and holding the left mouse button on its
title bar; they can either be left detached or docked around the Workbench window. They can also
be maximised by double-clicking on the title bar and doing it a second time will bring it back to
its original size and position. To manage the screen space better, views can be stacked on top of
each other and viewed by clicking on the tabs above the stacked views. The active view will have a
highlighted tab.

Most views also have menus of their own which can be accessed by clicking the drop down arrow
in the top right corner of the view. Sometimes they may even have their own toolbars.

The following sections describes the views that form the AMPL perspective.

Project Explorer

As explained in section 3.3, the Project Explorer view (figure 3.3) displays the projects in the workspace
in a tree-structure. All the functions are the same as described in the Eclipse manual for the Project
Explorer view with the addition of some AMPL specific functions, which are active in the AMPL
perspective.

Iy Project Explorer 23 | = "5 g
. 28 ALM
. =2 BondStripping
4 =8 Demo
|A] AModel.ampl
4 122 Diet
. [= data
4 = model
|A] diet.mod
(= script
fort.15
. 122 Production
. =8 Tracking

Figure 3.3: The Project Explorer view in the AMPL perspective

The context menu (pop-up menu on right-clicking, figure 3.4) allows you to add AMPL projects
and files into the workspace, without going through the File menu wizards. The Run As... and the
Debug As... also have an AMPL quick launch option, if the selection is an AMPL file. On clicking
this quick launch, only the selected file is run by AMPL. In order to run multiple files, you must create
a launch configuration (see section 5.2)

Console

This view displays all the output and runtime errors from AMPL and SAMPL and allows user to enter
commands and input data. For more details, see section 5.4.

Outline

This view (3.5) shows the list of model components, such as parameters, sets, variables, objectives
and constraints, for the AMPL file currently open in the editor.

Solution

This view displays the solution report for the last run. For more details, see section 5.5.
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[ Project Explorer 52| (5] 5 ¥ = & diet.mod diet.dat [A] AModel.ar
> 28 ALM set PROD ; # products
> 128 BondStripping X
4 [ Deoal param rate { PROD } > @; # tons pi
A New » |9 Project..
4 25 Die Go Into i 3
. B [Af AMPL File 3
4 = B Copy Ctrl+C | (B  AMPL Project
Paste Ctrl+V [f{ Data File i
=] 3¢ Delete Delete | [% File 3
= i
G pre Move... % Folder
. R Tra Rename... F2 | [f} ModelFile W
oy [[importe [5f SAMPLFile 1
% et [A  Script File
=
&) Refresh g |Cd Cther... Ctrl+M
"= Bands coils
Close Project
Close Unrelated Projects rate profit market :=
I
Run As 3
Debug As 3
Team » _display at this time,
Compare With 4
Restore from Local History...
Properties Alt+Enter
=2 Demo

Figure 3.4: Context menu in Project Explorer

File Edit MNavigate Search Project Run Window Help

™ e e R B R R R IR RS CRC R
Quick Access ﬁ|

[(H® ™ = 8 [A] AModel.ampl 53 = 0 | g=outlineE = O
=] <)==D = set PROD ; # products -
A i
g .[’—__;;ALM o param rate { PROD } > @; # tons produced per hour 4 25 Model
> l= BondStripping param avail >= @; # hours available in week {} PROD
4 28 Demo () rate
[A] AModel.am param profit { PROD }; # profit per ton () avail
4 25 Diet param market { PROD } >= @; # limit on tons sold in week () profit
> & data var Make {p in PROD } >= @, <= market [p]; # tons produced r () market
4 [= model x Make
[A] diet.mo: # Objective : total profits from all products fx Total_Profit
(= script maximize Total Profit : sum {p in PROD } profit [p] * Make [p]: 7 Time
5| fort15  Comstraint : totsl of h 4 by a11 a4 - Data
A - onstraint : total of hours used by a
g b_n' PdeLfCtan # products may not exceed hours available m {} PROD
» Iz Tracking subject to Time : sum {p in PROD } (1/ rate [p]) * Make [p] <= avai () rate
() profit
data ; () market
() avail
set PROD := bands coils ;
«|

El Console 52

Mo consoles to display at this time.

4 (1 |

[A] AModel.ampl - Demo

Figure 3.5: Outline view

3.4 Editors

The model and data source files are opened, modified and saved using the editor. Different types of
files have their own editors associated with them. When you double-click on any file in the views, it
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will automatically open it in the editor area with its respective editor. If there are multiple editors
open at one time, then they are stacked in the editor area but can be separated in the same manner
as how views are moved around except that they cannot be detached completely. When a file's name
tab has an asterisk (*), it means there are still unsaved changes in that file.

Content Assist

The AMPL and SAMPL editors support content assist, which greatly improves the productivity when
coding. Based on the context of the editing session, content assist provides the developer with a list
of accessible keywords according to AMPL specification and the currently defined entities.

It is sufficient to begin writing a word in the editor and press CTRL+SPACE to bring up the content
assist window, which will suggest various possible terminations for the prefix which has been typed.

LY AMPL - Manual/ContentAssistampl - AMPLDev - O
File Edit MNavigate Search Project Run  Window Help
el Do # B i o v| e Quick Access £ | | jg AMPL
o Pr. 2 = 0 [A] =ContentAssistampl 2 [A] MyModelFile.mod = 0 Oson. 2 = O =
9% 7 set MYSET; =
4 =8 Manual

[A] ContentAssist.ampl var MyVariable{MYSET}; Cbjecte

Variable Value Re
A MyModelFile.mod
Al include M

(file) MyMadelFile.mod
MyVariable: (var) MyVariable{ MYSET}:
MYSET: (set) MYSET:

< >

Constraint  Body [

Writable Insert 5:10

Figure 3.6: Content assist

3.5 Preferences

AMPLDev SP has many options which can be configured opening the Windows menu and clicking
the Preferences item (see figure 3.7). These options affect, among others, appearance (e.g. colors
and fonts), and default behaviour of the workspace management system.

Pre launch script

Some AMPL and SAMPL specific configuration options can be set from the same menu under the
AMPL and SAMPL labels.

Clicking on the headings AMPL and SAMPL brings up the prelaunch window for the respective
environment. It is an AMPL or SAMPL script which is executed every time a launch configuration is
solved. It can be used to specify options which need to be global and common for all executed scripts
on a particular machine (e.g. what solver to use or some commands to send emails after finishing the
solution process).

Search paths

Under AMPL, clicking on Search path the user can select the search path for the current AMPLDev
SP installation (see figure 3.8). Any directory specified here will be searched for executables when
running any launch configuration. It can be used to specify the location of solvers or other utility
programs which are used only in AMPLDev SP session without modifying the global system path.
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General

General

AMPL
Ant [ Keep next/previous editor, view and perspectives dialog open

[] Ahways run in background

Help [] Show heap status
Install/Update Open mode

Java @ Double click
Run/Debug
SAMPL
Team

() Single click
Select on hover
Open when using arrow keys

Note: This preference may not take effect on all views

[ Restore Defaults ] ’ Apply

[ ok ][ cance |

Figure 3.7: Preferences

type filter text Search Path
» General
a4 AMPL CA\Optirisk\ AMPL
Search Path

Ant
Help
Install/Update
Java
Run/Debug
SAMPL
Team

Warning! AMPLDev must be restarted in order for any changes to take effect.

’ Restore Defaults ] ’ Apply

[ ok || Cancel |

Figure 3.8: Search Path

TIP:

Eclipse has extensive documentation on the Eclipse Workbench which can be found online on
their website at http://help.eclipse.org/juno/index.jsp (Eclipse Juno 4.2) and can also be
accessed via the software's Help menu. This is the version AMPLDev SP is built on.



http://help.eclipse.org/juno/index.jsp

Part 11

Modelling with AMPLDev SP
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Chapter 4

Projects within AMPLDev SP

The following sections describe the different ways you can create a project, add files to it and use
some of the available templates.

If you are starting Eclipse for the first time, follow the steps described in section 3.1 to start the
Eclipse workbench.

4.1 Concept of a project

A project is a collection of source code and any supporting files such as documentation and data
that may be arranged using folders in a way similar to organizing files in the filesystem. Projects are
contained within workspaces described in section 3.1.

Some projects are associated with one primary language and occasionally some supporting lan-
guages; it is not possible to add unsupported language files in such a project. This does not apply to
the workspace which can have a mix of various types of projects under it.

You can organise files and folders in any manner as you please under the project root.

4.2 Creating a new project

There are numerous ways to create a project. In general, you do not need to be in the AMPL
perspective to create an AMPL project.
Using the File menu in a non-AMPL perspective
This is the most universal method of creating a new project.
1. Go to the File menu.
2. Select New.
3. Select Project....

4. A New Project dialog will open which will ask you to select a project wizard. Choose AMPL
Project under the AMPL category (see figure 4.1) and then click Next.

5. Give the project a name. You can either choose the default workspace location, or browse for
another location. The Create model, data and script directories option as its name suggest
creates the three respective folders in your project, if you check it (figure 4.2). You can always
create the folders later (using the context menu of the project). These folders are independent
of the files you put in them and is only for your personal organization. For example, you can
put a .mod file in the data folder. They are not restrictive by type (see figure 3.3).

14
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Select a wizard

Wizards:
type filter text

» = General
4 [= AMPL
125 AMPL Project
s = Java

Figure 4.1: Eclipse New Project dialog

6. After clicking Finish, AMPLDev SP will ask you if you want to change to the AMPL perspective,
if you are not in the AMPL persperctive.

7. The project has been created and you will be able to see it in Project Explorer.

Using the File menu in the AMPL perspective

To create a project in the AMPL perspective is fairly straightforward.
1. Go to File menu.
2. Select New.

3. Choose AMPL Project and follow the steps as described in the previous section to create the
project.

TIP:

There is the New button (T7) in the toolbar which is present in all perspectives by default. Clicking
this button opens a dialog to create a new file or a project.

Create an AMPL project

Enter a project name.

Project name:

Use default location
D:\ShareSVAMPL Workspaces\LP Solutions\LPW Browse...

[7] Create model, data and script directories

Figure 4.2: AMPL Project wizard
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Using the Project Explorer context menu in the AMPL perspective

The context menu is the menu that pops up with the right click (or command + click for a Mac). In
the AMPL perspective when right-clicking in the Project Explorer view, there are shortcuts to create
a project.

4.3 Creating and adding files to an AMPL project

Before describing the steps to create and add files, here is a brief description on the types of files
supported by the AMPL plug-in for Eclipse.

Supported AMPL file extensions

The three traditional AMPL file extensions are .mod for model files, .dat for data files and .run for
script files. They are all supported by AMPLDev SP.

In addition we have introduced a new file extension for AMPL files; you can now create an .ampl
file which can also be used for AMPL code. Similarly, we have .sampl for SAMPL code. The .ampl files
encompass all aspects of the .mod, .dat and .run file types; for example, you can have TestModel.ampl,
TestData.ampl and TestScript.ampl which can have the same code as TestModel.mod, TestData.dat
and TestScript.run. This will not make a difference while executing the files because the AMPL
translator treats all the files in the same way regardless of their extension.

We recommend using the .ampl extension for new files because the .mod and .dat extensions are
often associated with other programs. For example, the .mod extension is often recognized as an
extension for audio files.

Create AMPL file

Most of the steps are the same as creating a project except this time we choose to create a new file.
1. Go to the File menu.
2. Select New.

3. If you do not see the options for all the different AMPL file types then select Other.... A wizard
dialog will open, where you can choose the file you would like to add under the AMPL category
and click Next.

4. The first field requires you to choose the project or a folder in the project in which the file must
be placed. Then choose a filename. As you can see from figure 4.3, the title of the wizard is an
AMPL File, so you do not need to enter the extension; this wizard will automatically create a
.ampl file.

5. Once you have filled in the required information, AMPLDev SP will create a new file in the
chosen project or project folder and open it in the editor.

Using other means

To create and add a file via the Project Explorer context menu in the AMPL perspective, is exactly
the same as the project creation described in section 4.2. The New File shortcuts are in the same
locations and you can follow the same steps for the file wizard as described in section 4.3.
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(8 New AMPLFil [T

AMPL File
Create a new AMPL file.

Enter or select the parent folder:

Demo

i
23 ALM
» 128 BondStripping
=2 Demo
» =2 Diet
- =2 Production
» 122 Tracking

File name:  myModel.ampl

[ Fnish |[ cancel |

Figure 4.3: New AMPL File wizard

17



Chapter 5

Running Models and Analysing
Results

Running a model written in AMPL requires the use of AMPL compiler/interpreter which translates
the model and combines the model and data into a machine-readable and solver-specific form, passes
it to one of the many solvers supported by AMPL. It then gets the results and executes any script
commands. In Eclipse, these runs are referred to as launches. It is possible to run a single file or
multiple files in the order you want. There is an additional default launch available for projects that
contain only one model and one data file.

Note: At this stage, debug functionalities are not implemented, so the Run and Debug buttons
have the same effect for AMPL projects.

5.1 Single file launch

The previous chapter covered how to create a project and add files to it. When you do a single run,
there is no relationship between the consecutive launches. For example, you cannot run a model file
first and then a corresponding data file; each launch will be independent and Eclipse will not be able
to associate the model with the data. (For doing that, refer to section 5.2).

The single file launch allows you to quickly run a file without creating a custom launch configu-
ration. A simple AMPL model that will work in a single file launch, is given below:

set PROD; # products

param rate {PROD} > O; # tons produced per hour
param avail >= O0; # hours available in week
param profit {PROD}; # profit per ton

param market {PROD} >= 0; # limit on tons sold in week
var Make {p in PROD} >= 0, <= market[p]l; # tons produced

# Objective: total profits from all products
maximize Total_Profit: sum {p in PROD} profit[p] * Makel[p];

# Constraint: total of hours used by all
# products may not exceed hours available

subject to Time: sum {p in PROD} (1/ratel[p]l) * Make[p] <= avail;

data;

18
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set PROD := bands coils;

param: rate profit market :=
bands 200 25 6000
coils 140 30 4000 ;

param avail := 40;

option solver cplexamp;

solve;

19

You may want to change the solver based on the ones installed on your machine, changing the
statement 'option solver cplexamp;’ accordingly.
There are two ways to run this code: context menu or launch toolbar. Both of them can be used

in any perspective.

Context menu launch

This method is fairly straightforward.

1. In the Project Explorer, select the file you wish to execute. For this example, we have placed

the code in the file steel.ampl.

2. Right click (or command + click for Mac) to open the context menu.

3. Select Run As or Debug As and you will see another menu pop-up (figure 5.1).

= <)==D =
. 22 ALM
. =2 BondStripping
a4 128 Demo
|A| steel.amnl
a 122 Diet MNew
. = data
4 = mode Open
[A di Open With
(= script|
fort[.al_' =l Cory
Paste

. 122 Productid
. =2 Tracking | 3 Delete

Move...

Rename...

Import...
Export...

G E

Refresh

g

Run As
Debug As

Team

Compare With

Replace With

Properties

set PROD ; # products

[A] steel.ampl 232

param rate { PROD } > @; # tons produced per hour
param avail »= @; # hours available in week
param profit { PROD }; # profit per ton
» |9; # limit on tons sold in we
=] @, <= market [p]; # tons pro
* its from all products

Ctrl+C
Ctrl+V

Delete

F2

F5

Alt+Enter

sum {p in PROD } profit [p] *

pours used by all
B hours available
in PROD } (1/ rate [p]) * Mak

|
B 1ampL

B 2sampL

Run Cenfigurations...

|A] steel.ampl - Demo

Figure 5.1: Context menu launch

4. This pop-up will have an option saying 1 AMPL. By selecting this, AMPLDev SP will auto-
matically create a launch configuration for this file and the file will be executed. The launch
configuration will have the same name as the file.
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Note: in the Project Explorer, if you right click on a project folder, the Run As or Debug As
will show you an AMPL option, but this is only valid for a default launch, refer to section 5.3.

Launch toolbar

Once you have created a default configuration like in the previous defined steps, you can see these
launches in the dropdown menus accessible with the Run (£2) and Debug (%) toolbar buttons (figure
5.2).

h Project Run  Window Help
e m e TR R R R o

3 [A] steel.ampl &2
= set PROD ; # products

param rate { PROD } > @; # tons produced per hour
param avail »>= @; # hours available in week

param profit { PROD }; # profit per ton
Figure 5.2: Launch toolbar
When you click the down arrow next to these buttons, you will see the previous launched config-

uration for steel.ampl. You will also see the other method of launching the file which is the Run As
or Debug As option, see figure 5.3.

Run Window Help
| B0 QGG
E“ 1 steel.ampl

iet.mod [A] diet.dat

B 2Diet
set PROD ; # products

B 3AM
param rate { PROD } > @; 4 Tracking

param avail >= 8; # hours -
5 Production

param profit { PROD }; #

param market { PROD } »>= Run As YR 1AMPL
Run Configurations... B 2SAMPL
var Make {p in PROD } »= ] )
Organize Favorites...

# Objective : total profits Trom all products
naximize Total Profit : sum {p in PROD } profit [p] * Make [p];

# Constraint : total of hours used by all
¥ products may not exceed hours available

Figure 5.3: Launch toolbar Run menu: 1 steel.ampl is the previously created launch configuration

This shortcut creates a launch configuration for the current selection which means if there is a
file selected in the editor or in the Project Explorer, it will launch that. In the case of steel.ampl,
since there already is a launch configuration it will not create a new one. You can even choose 1
steel.ampl if you would like to launch that file again.

As mentioned before, the launches are independent of the file extension; so whether you run an
.ampl file, a .mod file or a .run file, AMPLDev SP will treat them the same way. The only exception
is for the files with the .dat extensions which will be run in the data mode (as if the files contain the
data statement at the beginning).

5.2 Multiple file launch

Having a single file execution is not always desirable; you may like to separate your model from the
data or have multiple models for some data and it is not ideal to put all the code in one file. For this
reason, there is a multiple file launch.
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In order to run multiple files, you will need to use the launch configuration dialog. This can
be found in either the context menu or launch toolbar shortcuts mentioned in the single file launch
(section 5.1). Looking at figure 5.1 and 5.3, you will see the option Run Configurations... (or
Debug Configurations...). by selecting that you will open the launch configuration dialog (figure
5.4).

I ‘% Run Configuratio X I

Create, manage, and run configurations

J = 33| = MName: Diet

type filter text File Selection =l Common

a [ AMPL L . . .
“ ALM The files listed below will be launched in the given order.

B Diet File Project

B Production ||| | model/diet.mod Diet

W steslampl ||| ata/dietdat  Diet Remove
B Tracking

Il Java Applet Remove All
[T Java Applicatior
Ju JUnit

SAMPL

Add

Up

/| Solve after executing the files listed above
Use the SAMPL translator

Filter matched 10 of 10 i

@)
S

Figure 5.4: Launch configuration dialog

Double click AMPL/SAMPL in the tree on the left, or right click it and select New. This will
create a new configuration and will open a clean File Selection tab on the right. You can give the
configuration a name to help differentiate between various configurations.

TIP:
You will notice that the configuration created earlier steel.ampl is also present on the left hand

side. By selecting that, you can add more files to it later on, if you wish to expand that code into
multiple files. So the single file launch can later be adapted for multiple files.

The File Selection tab

In this tab, you can add the files you wish to run together. Start by clicking the Add button to add
some files. This will open a window with a list of all the files in their respective projects and folders
(figure 5.5). If you click the folder, all the files in it will be selected.

After selecting the files, they will be automatically added to the table so you can now select the
order in which you would like to execute them by selecting the file in the table and clicking the Up and
Down buttons to move the selection (figure 5.4). Clicking Apply just saves the changes, although
Eclipse will always ask you to save if there are any unsaved changes before you launch.

You will also notice two checkboxes under the table. The first one (Solve after executing the
files listed above) is the equivalent of writing ‘solve;’ at the end of your AMPL code. If checked
AMPL will automatically solve after running the files selected in the table. This will also populate the
Solution view (see section 5.5). The second one (Use the SAMPL translator) specifies whether to
use the SAMPL translator instead of the AMPL one.
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W Launch File Selectio

Select the files for this launch configuration:

=8 ALM
=2 BondStripping
=2 Demo
o [0 Diet
a [V = data
J| [A] diet.dat
4 [J] = model
V| [A] diet.mod
= script
=2 Production
=2 Tracking

[ selectal || Deselectan |

Figure 5.5: Selecting the files for the launch configuration

Once you are ready to run the set of files, hit the Run or Debug button and your files will be
executed.

5.3 Default launch

This launch is available for projects that contain only one model (.mod) and one data (.dat) file. This
is to avoid the hassle of creating a launch configuration (as it comes under the multiple file launch),
for a simple project structure.

You do not need to do anything special for using this type of launch; AMPLDev SP automatically
checks whether the launch conditions of one model and one data file are satisfied in the project and
creates a default configuration. You use the same shortcuts as described in single file launch (section
5.1).

The main difference is that when you have a one model and one data project you can even launch
it from the project folder's context menu via Run As or Debug As. If these conditions are not
satisfied then, AMPLDev SP will ask you to create a launch configuration.

5.4 Viewing output and errors

While a run is in progress the output and errors if there are any will show up in the Console view.
This view is generally located in the bottom panel of AMPLDev SP. If it is not visible you can view
it via the Window menu, selecting Show View and then choose the Console view.

The console is interactive; you can enter and execute arbitrary commands there (see figure 5.6).
The text entered by the user is colored differently from the output text.

In the case of an error the detailed information and a hyperlink to the error location if available
is shown in the console (figure 5.7). In this example, there is a syntax error because ‘cost’ has been
mistyped. The location hyperlink contains the name of the file, the line number and the offset from
the beginning of the file. Clicking the hyperlink opens the file in the editor and highlights the line
presumably containing the error. Note that in some cases the error may be located in the code above
this line, for example in the case of missing semicolon.

You can use the ‘display’ and ‘print’ commands to output various information from your AMPL
code to the console.
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&l Console 23 |||=9'E'l=j'='ﬁ
AMPL

License expires on (y)2813:(m)12:(d)31.

OptiRisk Systems license manager: valid license found

Host: development

OptiRisk Development license

ampl:

cd 'D:\ShareS\AMPL Workspaces\LP Solutions\LPWorkspace\Demo' ;
FortMP 3.2j: LP OPTIMAL SOLUTION, Objective = 192808

ampl: display PROD;

set PROD := bands coils;

ampl: |

Figure 5.6: Console view

[Al diet.mod &2 | [A] diet.dat [A] steel.ampl = 8

set FOOD ;

set NUTR ;

# Parameters

param cost { FOOD } > @;

param T_min { FOOD } »>= @;

param f_max {j in FOOD } »= f_min [j];
param n_min { NUTR } »= @;

param n_max {i in NUTR } >= n_min [i];
param amt {NUTR , FOOD } »>= @;

# Variables

var Buy {j in FOOD } »>= f_min [j], <= f_max [j];
# Objective

inimize total cost : sum

# Contraints
subject to diet {i in NUTR }:
n_min [i] <= sum {j in FOOD } amt[i,j] * Buy[j] <= n_max [i]; _

L2

&l Console 32 ||| =R
AMPL

MOST: Gevelopment
OptiRisk Development license

m

cd 'D:\ShareS\AMPL Workspaces\LP Solutions\LPWorkspace\Diet' ;

./model/diet.mod, line 13 (offset 355):
cst is not defined -

Fl 10 L3

Figure 5.7: Error shown in the Console view

5.5 Viewing the solution

The solution report will be displayed in the Solution view (generally located in the right panel of the
AMPL perspective. If you cannot see it then you can open it via Window — Show View...). This
view is only populated if the Solve after executing the files listed above option is checked for the
launch configuration (see figure 5.4).

There are three sections in the Solution view, refer to figure 5.8. The first part states the
Objective value and the name of the objective function in brackets.

The first table describes the variables and their corresponding values. Reduced Cost is the
amount by which the objective value would improve if the value of the corresponding variable is
increased by one. Slack is the distance from the bound.

The second table describes the constraints where Body is the body of the constraint, Dual Value
is an indication of how much the objective value can be increased if the constraint is relaxed by one
unit and lastly Slack is the distance between the body of the constraint and its bound.
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5 Solution 52 =
Objective: 118.0594 (total_cost)
Variable Walue Reduced Cost Slack
Buy['BEEF'] 53808 0.0 3.3606
Buy['CHK'] 2.0 11888 0.0
Buy['FISH'] 2.0 11444 0.0
Buy['HAM'] 100 -0.3027 0.0
Buy['MCH'] 100 -0.5512 -0.0
Buy['MTL'] 100 -1.3289 0.0
Buy['SPG'] 93061 0.0 0.6939
Buy[ TURT 20 27316 0.0
Constraint  Body Dual Value Slack
diet['A'] 19562882 0.0 1256.2882
diet['C'] 16825149 0.0 982.5149
diet['B1']  1036.2575 0.0 336.2575
diet['B2'] 7000 0.4045 0.0
diet['MAT 500000 -0.0031 0.0
diet['CAL'] 197946206 0.0 3794.6206

Figure 5.8: Solution view
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IMPORTANT NOTE:

For the complete AMPLDevSP manual which contains the AMPL and SAMPL
reference parts outlined in the contents, please download the AMPLDevSP software or email
us at sales@optirisk-systems.com

The complete manual contains examples along with their corresponding source code
in AMPL/SAMPL and their algebraic formulations.


http://www.optirisk-systems.com/downloads_software.aspx
mailto:sales@optirisk-systems.com

